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CBSE | DEPARTMENT OF SKILL EDUCATION 
Information Technology (SUBJECT CODE - 402) 

Blue-print for Sample Question Paper for Class X (Session 2024-2025)  

 
Max. Time: 2 Hours            Max. Marks: 50  
 

General Instructions:  
 
1. Please read the instructions carefully.  

2. This Question Paper consists of 21 questions in two sections: Section A & Section B.   

3. Section A has Objective type questions whereas Section B contains Subjective type questions.  

4. Out of the given (5 + 16 =) 21 questions, a candidate has to answer (5 + 10 =) 15 questions in the 

allotted (maximum) time of 2 hours.  

5. All questions of a particular section must be attempted in the correct order.  

6. SECTION A - OBJECTIVE TYPE QUESTIONS (24 MARKS): 

i. This section has 05 questions.  

ii. Marks allotted are mentioned against each question/part.  

iii. There is no negative marking.  

iv. Do as per the instructions given.  

7. SECTION B – SUBJECTIVE TYPE QUESTIONS (26 MARKS):  

i. This section has 16 questions.  

ii. A candidate has to do 10 questions.  

iii. Do as per the instructions given.  

iv. Marks allotted are mentioned against each question/part.  
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SECTION A: OBJECTIVE TYPE QUESTIONS 
 

Q. No. QUESTION Marks 

Q. 1 Answer any 4 out of the given 6 questions on Employability Skills (1 x 4 = 4 marks)  

i. (b) Cultural barrier 1 

ii. (c) Both internal and external 1 

iii. (a) takes responsibility for his mistakes 1 

iv. (b) The ability to control one’s emotions, thoughts, and behavior in various 
situations 

1 

v. (b) Life on land 1 

vi. (c) It can prevent data from getting corrupt 1 

Q. 2 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks) 

i. (b) Fill Format option 1 

ii. (c)  Hyperlink 1 

iii. (c) 10 1 

iv. (d) We cannot create our own templates 1 

v. (b) By using the What-if scenario feature in the spreadsheet to create and 
analyse different budget options 

1 

vi. (c) To ensure easy and safe use of equipment, reducing the risk of injury 1 

Q.3 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)   

i. (b) Sub, End Sub 1 

ii. (a) It reduces the document size by storing only the reference to the image. 1 

iii. (b) Select Edit > Track Changes > Compare Documents option. 1  

iv. (d) Text Wrapping 1 

v. (b) It automatically groups data and applies common functions like sum and 
average. 

1 

vi. (b) Stretching at regular intervals or doing simple yoga 1 

Q.4 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)  

i. (b) Relative 1 

ii. (a) IDE 1 

iii. (b) Organized and processed data that provides meaningful insights. 1 

iv. (c) Every foreign key value must match a primary key in the referenced table or 
be null. 

1 

v. (b) Rest eyes periodically and do simple eye exercises 1 

vi. (a) Relational Data Model  1 

Q.5 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)  

i. (b) It uniquely identifies each record in a table. 1 

ii. (d) Add Table or Query 1 

iii. (c) Report 1 

iv. (c) Seek conflict resolution strategies with colleagues 1 

v. (b) Sitting in a wrong posture and using an uncomfortable chair 1 

vi. (b) A fire extinguisher 1 
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SECTION B: SUBJECTIVE TYPE QUESTIONS 

Q. No. QUESTION Marks 

Q.6 Think Before You Speak  
• Think about your topic.  
• Think about the most effective ways to make your listeners understand the 
topic.  
• Write or note down whatever you plan to say.  
Concise and Clear  
• Speak clearly, loudly and at moderate speed.  
• Be sure the information you want to share is to the point. 
• Do not repeat the same sentences.  
Confidence and Body Language  
• Be confident.  
• Maintain eye contact, stand straight and be attentive.  
• Be friendly 

2 

Q.7 Functions of an Entrepreneur are:  
1. Making Decisions: Entrepreneurs make daily choices about what to 

produce or sell, pricing, and market locations. 
2. Managing the Business: They plan the business's future, arrange for 

raw materials, hire staff, and ensure plans are followed. 
3. Dividing Income: Entrepreneurs allocate business funds for materials, 

rent, and salaries. 
4. Taking Risks: They face risks related to fires, theft, and lost items. 
5. Creating New Methods, Ideas, or Products: Entrepreneurs innovate to 

enhance their business's significance and profitability. 

2 

Q.8 To safeguard your data from theft and viruses, consider the following measures: 
1. Use Strong Passwords: Create difficult-to-guess passwords using a mix 

of lowercase and uppercase letters, numbers, and special characters. 
This prevents unauthorized access to your computer. 

2. Install Anti-virus and Firewall: These tools monitor incoming and 
outgoing data, preventing viruses from entering and detecting any that 
may have already accessed your system. 

3. Encrypt Data: Important information can be encrypted using tools like 
BitLocker, requiring a decryption password to access the hard disk, thus 
blocking unauthorized usage. 

4. Secure Sites: Only share credit card or bank information on secure sites, 
indicated by “https://” and a lock symbol in the browser's address bar. 

2 

Q.9   Tracking time helps to: 
● Identify time-wasting activities and unproductive habits 
● Improve time management for studies and tasks 
● Balance academics with extracurriculars and personal time 
● Allocate time for relaxation and self-care 
● Achieve academic goals more efficiently and reduce stress before exams 

2 

Q.10 The 17 SDGs have been made with the aim of taking care of important issues 
facing businesses, governments and society. Some of these issues are poverty, 
gender equality, water use, energy, climate change and biodiversity. Countries 
are now making policies and regulations that will promote sustainable systems 
needed in all economic sectors to provide a secure, affordable and sustainable 
economy. 

2 

Q.11 A Style is a collection of all formatting information, which you want to save and 
then apply on the document. Writer provides six Style categories – Page, 
Paragraph, Character, Frame, List and Table.(Mention any two) 

2 
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Q.12 Safety: The work environment of the organisation must be safe. It must be free 
from hazards and risks. A hazard is something that can cause harm to the people 
Security: Every employee working in an organisation must feel that they are 
secured in the company campus. Security is a kind of freedom from any potential 
harm. Security ensures the safety of the people working in the organisation. This 
include various security such as personal safety, computer system safety, 
electrical safety, transport safety and other equipment safety. 

2 

Q.13 A shared spreadsheet is a same sheet that can be accessed by more than one 
user and can allow them to make changes simultaneously on it. It saves the 
trouble of keeping track of multiple copies of the same spreadsheet. Sharing 
allows working in collaboration so that everyone can contribute, make changes 
and view it. 

2 

Q.14 Tools > Goal Seek                                                                             2 

Q.15 While working with multiple tables, you need to check the redundancy and 
inconsistency of data. The record for a particular entity should neither be 
repeated nor different data values should appear for a single entity in the 
database. This is done by setting relationships between the tables of a database. 

2 

Q.16 Occupational overuse syndrome, also known as repetition strain injury (RSI), is 
a collective term for a range of conditions, characterised by discomfort or 
persistent pain in muscles, tendons and other soft tissues, with or without 
physical manifestations. It is usually caused or aggravated by work and is 
associated with repetitive movement, sustained or constrained postures and/or 
forceful movements 

2 

Q.17 a) Track Changes is a powerful tool that makes the process of commenting, 
editing and reviewing a document easy between multiple users. A document 
created by one user needs to be reviewed and edited by self or other users. If 
any modifications are made in the document directly, the original document might 
get lost. Instead, the Track Changes feature of Writer offers an alternative 
method to keep a record of all the changes made in the original document. All 
the changes that are recorded can be either accepted or rejected by the original 
author. 
b) View > Toolbars > Track Changes. 
c) Yes 
d) Original Author 

4 

Q.18 a) Repetitive tasks like calculating average scores, ranking teams based on 
performance, and generating graphs could be done with macros. It will save time 
and effort. 
b) Tools > Options > LibreOffice > Advanced. Observe the Optional Features. 
Two options are not check marked. Put the checkmark on the option “Enable 
macro recording” 
c) No, solution*word is not a valid macro name. Macro names cannot include 
special characters such as asterisks (*) or spaces. Valid characters typically 
include letters, numbers, and underscores. 
d) Opening or switching of windows 

4 
 

Q.19 a) A form is an object of the database that has a user-friendly interface where 
data can be entered and seen in an attractive and easy-to-read format. For any 
database, it is the front end for data entry and data modification 
b) There are two ways to create a form: • Using a wizard • Using the Design View 
c) Forms Control Toolbar 
d) The Records toolbar contains the navigation control buttons in the extreme 
left. With the help of these buttons, we can traverse and view the records in the 
file 

4 

Q.20 • All employees must know where the fire extinguishers are located, and how 
to properly use them.  

• Fire extinguishers and First Aid Stations should be clearly marked with 
signs.  

4 
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• Never block access to Exits, fire extinguishers, electric switches and panels. 

• Do not block or stack material against doors, which would prevent them from 
operating properly in event of a fire. 

• Do not use flammable material near electrical panels, switches, lift trucks or 
any electrical equipment.  

• Make sure all equipment is properly grounded where needed.  

• Fire extinguishers must be inspected regularly. 

• Report to your supervisor of any defect in electrical, fire prevention or 
material handling equipment.  

• No flammable material are to be placed around an exit door way. (Any 4 
points) 

Q.21 a) A Database Management System (DBMS) is software that helps users create, 
manage, and manipulate databases. It allows for efficient data storage, retrieval, 
and organization. 
b) Advantages of using DBMS: 

● Data Integrity: Ensures accuracy and consistency of data. 
● Data Security: Provides access controls to protect sensitive information. 
● Reduced Data Redundancy: Minimizes duplication of data across the 

database. 
● Data Management: Simplifies data handling through structured query 

language (SQL). 
c)Two database programs: 

● MySQL 
● Open Office Base 

d)  The ISBN (International Standard Book Number) can be set as a primary key, 
as it uniquely identifies each book in the inventory.] 

4 
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CBSE | DEPARTMENT OF SKILL EDUCATION 
Information Technology (SUBJECT CODE - 402) 

Blue-print for Sample Question Paper for Class X (Session 2024-2025)  

 
Max. Time: 2 Hours            Max. Marks: 50  
 

PART A - EMPLOYABILITY SKILLS (10 MARKS):  

UNIT 
NO.  NAME OF THE UNIT  

OBJECTIVE TYPE 
QUESTIONS  

SHORT ANSWER 
TYPE QUESTIONS  

TOTAL 
QUESTIONS    

  1 MARK EACH  2 MARKS EACH   

1 Communication Skills - II 1             1 2  

2 Self-Management Skills - II 2  1  3  

3 ICT Skills - II 1  1 2 

4 Entrepreneurial Skills - II 1 1 2 

5 Green Skills - II 1  1 2 

TOTAL QUESTIONS 6  5  11  

NO. OF QUESTIONS TO BE ANSWERED Any 4 Any 3 07  

TOTAL MARKS 1 x 4 = 4 2 x 3 = 6 10 MARKS 

 

PART B - SUBJECT SPECIFIC SKILLS (40 MARKS):  

UNIT 
NO.  

NAME OF THE UNIT  

OBJECTIVE  
TYPE  

QUESTIONS  

SHORT  
ANSWER TYPE 

QUESTIONS  

DESCRIPTIVE/  
LONG ANS. TYPE 

QUESTIONS  TOTAL 
QUESTIONS  

1 MARK EACH  2 MARKS EACH  4 MARKS EACH  

1 
Digital Documentation 
(Advanced) 6  1  1  8  

2 
Electronic Spreadsheet 
(Advanced) 6  2  1  9  

3  
Database Management 
System 6  1  2  9  

4  
Maintain Health, Safety 
and Secure Working 
Environment 

6  2  1  9  

 TOTAL QUESTIONS 24  6  5  35  

 NO. OF QUESTIONS TO 
BE ANSWERED 

20 Any 4 Any 3  27 

 TOTAL MARKS 1 x 20 = 20 2 x 4 = 8 4 x 3 = 12  40 MARKS 

 



Page 2 of 8 
 

CBSE | DEPARTMENT OF SKILL EDUCATION 
Information Technology (SUBJECT CODE - 402) 

Blue-print for Sample Question Paper for Class X (Session 2024-2025)  

 
Max. Time: 2 Hours            Max. Marks: 50  
 

General Instructions:  
 
1. Please read the instructions carefully.  

2. This Question Paper consists of 21 questions in two sections: Section A & Section B.   

3. Section A has Objective type questions whereas Section B contains Subjective type questions.  

4. Out of the given (5 + 16 =) 21 questions, a candidate has to answer (5 + 10 =) 15 questions in the 

allotted (maximum) time of 2 hours.  

5. All questions of a particular section must be attempted in the correct order.  

6. SECTION A - OBJECTIVE TYPE QUESTIONS (24 MARKS): 

i. This section has 05 questions.  

ii. Marks allotted are mentioned against each question/part.  

iii. There is no negative marking.  

iv. Do as per the instructions given.  

7. SECTION B – SUBJECTIVE TYPE QUESTIONS (26 MARKS):  

i. This section has 16 questions.  

ii. A candidate has to do 10 questions.  

iii. Do as per the instructions given.  

iv. Marks allotted are mentioned against each question/part.  
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SECTION A: OBJECTIVE TYPE QUESTIONS 
 

Q. 1 Answer any 4 out of the given 6 questions on Employability Skills (1 x 4 = 4 marks)   

i.  Rahul moved to Japan from India for work. However, he struggles to adapt 
because he is not familiar with Japanese customs and etiquette, which affects his 
interactions with coworkers. This is an example of: 
(a) Interpersonal barrier 
(b) Cultural barrier 
(c) Physical barrier 
(d) Linguistic barrier 

1  

ii.  Amina studies diligently to improve her grades because she wants to feel proud 
of her achievements and also earn a scholarship. What type of motivation is this? 
(a) Internal 
(b) External 
(c) Both internal and external 
(d) Not any specific type of motivation 

1  

iii.  Rajesh launches a new app, but it fails to attract users and he faces financial 
losses. He gathers his team to discuss the failure, takes accountability for the 
oversight, and assures them that he will conduct thorough market research 
before the next launch. He _______________________. 
(a) takes responsibility for his mistakes 
(b) thinks before making a decision 
(c) does not give up 
(d) is innovative 

1  

iv.  Which of the following best describes self-management? 
(a) The ability to ignore emotions and focus solely on tasks 
(b) The ability to control one’s emotions, thoughts, and behavior in various situations 
(c) The ability to manage time efficiently without considering feelings 
(d) The ability to rely on others for emotional support 

1  

v.  A community initiates a tree-planting campaign to restore local forests, aiming to 
enhance biodiversity, prevent soil erosion, and provide habitats for wildlife. This 
initiative also includes educating residents about sustainable land use practices 
to protect their natural environment. 
Which SDG can you relate this initiative to? 
(a) Clean Water and Sanitation 
(b) Life on Land 
(c) Affordable and Clean Energy 
(d) Climate Action 

1  

vi.  How can an anti-virus protect your device? 
(a) It can protect it from over-heating 
(b) It can increase its performance 
(c) It can prevent data from getting corrupt 
(d) It can backup data 

1  

 

Q. 2 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)   

i.  Which feature in Writer allows you to apply the same style to multiple words 
scattered throughout the document? 
(a) Format Painter 
(b) Fill Format option 
(c) Style Inspector 
(d) Font Adjustment Tool 

1 

ii.  Which feature allows you to jump to a different document, spreadsheet, or 
website from within a document? 
(a) Bookmark 
(b) Page Break 

1 
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(c) Hyperlink 
(d) Format Painter 

iii.  How many levels of headings does LibreOffice Writer support? 
(a) 5 
(b) 8 
(c) 10 
(d) 12 

1 

iv.  Which of the following is NOT true about templates?  
(a) The styles and formatting features can be reused.  
(b) Libre Office provides online templates 
(c) Templates can have headings, text formats, styles, page numbers, headers and 
footers 
(d) We cannot create our own templates 

1 

v.  Radha is planning a school event and wants to decide how much money to 
allocate for different activities, like games, food, and decorations. She creates 
several different budget plans to see how changing the amount for each 
category affects the total expenses. 
How can Radha efficiently compare the different budget plans for her school 
event in the same spreadsheet? 
(a) By writing down each budget on paper 
(b) By using the What-if scenario feature in the spreadsheet to create and analyze 
different budget options 
(c) By asking her friends to guess the costs 
(d) By using the Filter function to look at one category at a time 

1 

vi.  What is the main goal of applying ergonomics in an office setting? 
(a) To increase the amount of work done in a shorter time 
(b) To design tasks that are more interesting for employees 
(c) To ensure easy and safe use of equipment, reducing the risk of injury 
(d) To promote social interactions among employees 

1 

 

Q. 3 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)   

i.  The code of macro begins with ____ followed by the name of the macro and 
ends with ____. 
(a) Function, End 
(b) Sub, End Sub 
(c) Sub, End Function 
(d) Sup, End Sup 

1 

ii.  What is the benefit of inserting an image as a link in a document? 
(a) It reduces the document size by storing only the reference to the image. 
(b) It enhances the image quality. 
(c) It allows for automatic image editing within the document. 
(d) It removes the need for image captions. 

1 

iii.  After incorporating the reviews, Krishna mailed the document to his editor with 
the Track Changes ON. He made certain changes in the document. Pradeep 
wants to compare his original document with the reviewed document. 
What is the first step Krishna should take to compare his edited document 
with the original document? 
(a) Open the Manage Changes dialog box. 
(b) Select Edit > Track Changes > Compare Documents option. 
(c) Save the edited file. 
(d) Accept or reject the desired changes. 

1 

iv.  It allows the placement of image in relation to text  
(a) Water mark (b) Trade mark (c) Copyright (d) Text Wrapping 

1 

v.  What is the primary function of the Subtotal tool in Calc? 
(a) It creates a chart for the data. 
(b) It automatically groups data and applies common functions like sum and 
average. 

1 
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(c) It highlights cells with conditional formatting. 
(d) It removes duplicate data from the spreadsheet. 

vi.  What is one way to mitigate hazards associated with prolonged computer 
use? 
(a) Increasing screen brightness 
(b) Stretching at regular intervals or doing simple yoga 
(c) Using a smaller screen 
(d) Sitting in a fixed position 

1 

 

Q. 4 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)  

i.  A ______________ hyperlink stores the location with respect to the current location 
in LibreOffice Calc. 
(a) Absolute 
(b) Relative 
(c) Mixed 
(d) Reference 

1 

ii.  ______________ is a text editor that allows you to create and edit macros. 
(a) IDE 
(b) Notepad 
(c) Open Office Writer 
(d) MS Word 

1 

iii.  Which of the following best defines "information"? 
(a) Unprocessed raw facts such as names, marks, and addresses. 
(b) Organized and processed data that provides meaningful insights. 
(c) Audio, video, and graphics stored without any processing. 
(d) A collection of unrelated raw facts. 

1 

iv.  What does referential integrity in a database ensure? 
(a) All primary keys are unique across the database. 
(b) All records in a table must have a value in every column. 
(c) Every foreign key value must match a primary key in the referenced table or be 
null.  
(d) Data can be freely deleted from any table without constraints. 

1 

v.  What should you do with the problem of dry eyes? 
(a) Forget to blink 
(b) Rest eyes periodically and do simple eye exercises 
(c) Do exercise 
(d) Blink the eyes 

1 

vi.  Which of the following data models sets a relation between the two or more 
tables?  
(a) Relational Data Model  
(b) Network Data Model 
 (c) Hierarchical Data Model  
(d) Connection Data Model 

1 

 

Q. 5 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)   

i.  Which of the following statements are true about primary key in a database? 
(a) It is a field that can have duplicate values. 
(b) It uniquely identifies each record in a table. 
(c) It can have null values 
(d) It is an optional field in a database table. 

1 

ii.  Which of the following dialog boxes appears when the Query Design window is 
opened for the first time to design a query? 
(a) Add Table 
(b) Add Query 
(c) Add Query or Report 
(d) Add Table or Query 

1 
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iii.  What feature in OpenOffice Base allows users to present retrieved data in a 
user-friendly and formatted manner? 
(a) Query 
(b) Form 
(c) Report 
(d) Data view 

1 

iv.  Which of the following is a recommended way to manage stress at work? 
(a) Engage in aggressive conflicts with colleagues 
(b) Work longer hours without breaks 
(c) Seek conflict resolution strategies with colleagues 
(d) Avoid hobbies that promote relaxation 

1 

v.  Which of the following can lead to musculoskeletal problems while working on 
a computer? 
(a) Using anti glare screen 
(b) Sitting in a wrong posture and using an uncomfortable chair  
(c) Using Air Conditioners 
(d) Taking frequent breaks 

1 

vi.  In a situation where a small fire breaks out in the office, what should you use to 
address the emergency? 
(a) A Blanket 
(b) A Fire Extinguisher 
(c) A Towel 
(d) Baking Soda 

1 
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SECTION B: SUBJECTIVE TYPE QUESTIONS 
 

Answer any 3 out of the given 5 questions on Employability Skills (2 x 3 = 6 marks)  
Answer each question in 20 – 30 words.  

Q. 6 During a team meeting, Sarah is explaining a complex project idea to her 
colleagues. She speaks too quickly, uses jargon, and doesn’t pause for 
questions. As a result, her team seems confused, and the project isn’t fully 
understood. 
What can Sarah do to improve her verbal communication skills? 

2 

Q. 7 What are the functions of Entrepreneurs? 2 

Q. 8 List the various ways you can use to protect your data. 2 

Q. 9 Riya, a Class X student, feels stressed with her exam preparation, 
extracurricular activities, and family commitments. How can tracking time help 
her? 

2 

Q. 10 Why has United Nations has made the 17 Sustainable Development Goals? 2 

 
Answer any 4 out of the given 6 questions in 20 – 30 words each (2 x 4 = 8 marks)  

Q. 11 In Open Office Writer, what are the styles? List two Open Office Writer style 
options. 

2  

Q. 12 Differentiate between safety and security of an employee. 2  

Q. 13 What are the benefits of sharing a spreadsheet? 2  

Q. 14 Guneet has completed his assessments in four subjects and received the 
following marks: 75 in Math, 68 in Science, 82 in English, and 70 in History. 
The student needs to achieve an overall aggregate of 75% across all five 
subjects to meet his academic goals. He still has to take the exam in the fifth 
subject, which is Geography. 
Which Calc tool and menu option he can use to check how many marks he 
has to score in the 5th subject to get the required percentage? 

2  

Q. 15 In a database, why is it important to create relationships between the tables? 2  

Q. 16 What is Occupational Overuse Syndrome? What are the causes for it? 2  

 
Answer any 3 out of the given 5 questions in 50– 80 words each (4 x 3 = 12 marks)  

Q. 17 A team of writers is collaborating on a report using a word processing software 
with a Track Changes feature. One writer creates the initial draft, which then 
needs to be reviewed and edited by the rest of the team.  

a) Why is the Track Changes feature essential for collaborative document 
editing? 

b) Which menu option can be used to access this feature? 
c) Can reviewers add comments?  
d) Once the changes are made by all the reviewers, who can accept or 

reject them? 

4 

Q. 18 A Class X student is participating in a school competition where they need to 
analyse the performance of different sports teams based on match scores 
and statistics. The student has collected data over several matches and 
needs to calculate averages, determine rankings, and generate charts for a 
presentation. 

a) How are Macros in Calc helpful to him? 
b) How to enable Macro in Calc? 
c) Is solution*word a valid macro name? Justify 
d) Mention any one operation which cannot be recorded by macro. 

4 



Page 8 of 8 
 

Q. 19 A health clinic is developing a patient management system to streamline 
patient intake, appointments, and medical records. They need to implement 
forms for various purposes, including new patient registration, appointment 
scheduling, and updating medical histories. 
a) What is the use of form in DBMS? 
b) What are the different ways to create forms in DBMS? 
c) Where can we find various tools to add or edit controls on the form? 
d) What is the use of the Records Toolbar in a form? 

4 

Q. 20 What points should be included in Fire Prevention Plan in the office? 4 

Q. 21 Your cousin runs a small bookstore and wants to maintain an inventory of 
books. He needs to record information such as book titles, authors, ISBNs, 
publication dates, prices, and stock levels. However, he is not familiar with 
database management systems. Explain the following concepts to help him 
understand DBMS: 

a) What is DBMS?  
b) What are the advantages of using DBMS? 
c) Name any two database programs that can be used to create a table 

and store the data according to his requirements. 
d) Which field can be set as a Primary Key? 

4  
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 will  be  distributed at 10.15 a.m. From 
10.15 a.m. to 10.30 a.m., the students will 
read the question paper only and will not 
write any answer on the answer-book 
during this period. 
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gm_mÝ` {ZX}e : 

(i) H¥$n`m {ZX}em| H$mo Ü`mZ go n‹T>| &  

(ii) Bg àíZ-nÌ _| Xmo IÊS>m| _| 21 àíZ h¢ : IÊS> H$ Am¡a IÊS> I & 

(iii) IÊS> H$ _| dñVw{ZîR> àH$ma Ho$ àíZ h¢ O~{H$ IÊS> I _| {df`naH$ àH$ma Ho$ àíZ h¢ &  

(iv) {XE JE (5 + 16) = 21 àíZm| _| go, Cå_rXdma H$mo 2 K§Q>o Ho$ Am~§{Q>V (A{YH$V_) g_` _| 
(5 + 10) = 15 àíZm| Ho$ CÎma XoZo h¢ & 

(v) {H$gr ^r IÊS> {deof Ho$ g^r àíZm| H$mo ghr H«$_ _| H$aZo H$m à`mg {H$`m OmZm Mm{hE & 

(vi) IÊS> H$ : dñVw{ZîR> àH$ma Ho$ àíZ (24 A§H$) :  
 (a) Bg IÊS> _| 5 àíZ h¢ &  
 (b) H$moB© ZH$mamË_H$ A§H$Z Zht h¡ & 
 (c) {XE JE {ZX}em| Ho$ AZwgma H$s{OE & 
 (d) àË`oH$ àíZ/^mJ Ho$ gm_Zo Am~§{Q>V A§H$m| H$m CëboI {H$`m J`m h¡ & 

(vii) IÊS> I : {df`naH$ àH$ma Ho$ àíZ (26 A§H$) : 
 (a) Bg IÊS> _| 16 àíZ h¢ &  
 (b) Cå_rXdma H$mo 10 àíZ H$aZo h¢ & 
 (c) {XE JE {ZX}em| Ho$ AZwgma H$s{OE & 
 (d) àË`oH$ àíZ/^mJ Ho$ gm_Zo Am~§{Q>V A§H$m| H$m CëboI {H$`m J`m h¡ & 

IÊS> H$  

 (dñVw{Zð> àH$ma Ho$ àíZ)  (24 A§H$) 

1. amoµOJma H$m¡eb na {XE JE 6 àíZm| _| go {H$Ýht 4  Ho$ CÎma Xr{OE &  41=4 

(i) µ\$mBb Zm_ Am¡a µ\$mBb Zm_ EŠgQ>|eZ H$mo EH$_________  Ûmam AbJ {H$`m OmVm 
h¡ &  

 (A) S>m°ba ($) (B) S>m°Q> (.) 

 (C) aoIm§H$Z (A§S>añH$moa) (_) (D) h¡e (#) 

(ii) {ZåZ{b{IV _| go {H$g àH$ma Ho$ g§dmX _| Ho$db {~å~ Am¡a {MÌm| Ho$ _mÜ`_ go 

g§Xoe AmXmZ-àXmZ (B§Q>aMopÝO¨J) {H$`m OmVm h¡ ?   

(A) _m¡{IH$ (d~©b) (B) gm§Ho${VH$ (OoñMa) 

(C) Mmjwf ({dµOwAb) (D) Moham (\o${e`b)  
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General Instructions : 

(i) Please read the instructions carefully. 

(ii) This question paper consists of 21 questions in two Sections : Section A 

and Section B.  

(iii) Section A has Objective Type questions, whereas Section B contains 

Subjective type questions.  

(iv) Out of the given (5 + 16) = 21 questions, a candidate has to answer  

(5 + 10) = 15 questions in the allotted (maximum) time of 2 hours.  

(v) All questions of a particular section must be attempted in the correct 

order. 

(vi) Section A  : Objective Type Questions (24 marks) :  

(a) This section has 5 questions.  

(b) There is no negative marking.  

(c) Do as per the instructions given.  

(d) Marks allotted are mentioned against each question/part.  

(vii) Section B : Subjective Type Questions (26 marks) :  

(a) This section has 16 questions.  

(b) A candidate has to do 10 questions.  

(c) Do as per the instructions given.  

(d) Marks allotted are mentioned against each question/part.   

Section A 

                                             (Objective Type Questions)                         (24 Marks)   

1. Answer any 4 out of the given 6 questions on Employability Skills. 41=4 

(i) The filename and filename extension are separated by a _________ .   

 (A) Dollar ($) (B) Dot (.) 

 (C) Underscore (_) (D) Hash (#) 

(ii) Which of the following type of communication involves 

interchanging messages only through images or pictures ? 

 (A) Verbal (B) Gesture  

(C) Visual  (D) Facial 
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(iii) _________ AnZo _Zmo^mdm| Am¡a Xÿgam| Ho$ _Zmo^mdm| H$mo nhMmZZo Am¡a g§Mm{bV 

H$aZo H$s `mo½`Vm h¡ &  

 (A) AmË_-~moY (goë\$-Ado`aZog) 

  (B) ^mdZmË_H$ {ddoH$ (B_moeZb B§Qo>{bO|g) 

 (C) X~md à~§YZ (ñQ´>og _¡ZoO_|Q>)   

 (D) ^mdZmË_H$ AdamoY (B_moeZb ~¡[a`a) 

(iv) _________EH$ àoaH$$ ~b h¡ Omo ì`{º$ H$mo bú` àmßV H$aZo, Iwer AZw^d H$aZo Am¡a 

OrdZ H$s JwUdÎmm gwYmaZo Ho$ {bE ào[aV H$aVm h¡ &   

 (A) X~md à~§YZ (ñQ´>og _¡ZoO_|Q>)  

 (B) AmË_-~moY (goë\$-Ado`aZog)  

 (C) AmË_-{dH$mg (goë\$-J«moW)   

 (D) ñd-àoaU (goë\$-_mo{Q>doeZ)  

(v) EH$ gµ\$b CÚ_r ~ZZo Ho$ {bE {ZåZ{b{IV _| go H$m¡Z-gm JwU A{Zdm`© Zht  h¡ ? 

 (A) AmË_{dídmg (H$m°pÝ\$S>|g)  

 (B) g¥OZerbVm ({H«$E{Q>{dQ>r) 

 (C) Y¡`© (noe|g)   

 (D) YZdmZ (d¡ëWr) 

(vi) Jar~r g_mßV H$aZo, YaVr H$mo gwa{jV aIZo Am¡a 2030 VH$ g^r bmoJ em§{V Am¡a 

g_¥{Õ àmßV H$a|, Bgo gw{ZpíMV H$aZo Ho$ {bE d¡pídH$ AmˆmZ Ho$ ê$n _| H$m`© H$aZo hoVw 

2015 _| g§`wº$ amîQ´> Ûmam Hw$b {H$VZo Eg.S>r.Or. (Sustainable Development 

Goals) AnZmE JE ? 

 (A) 13 (B) 11 $  

 (C) 17 (D) 19$ 
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(iii) _________ is the ability to identify and manage one’s own emotions, 

as well as the emotions of others.  

 (A) Self-Awareness   

 (B) Emotional Intelligence   

 (C) Stress Management    

 (D) Emotional Barrier   

(iv) _________  is the driving force that pushes us to achieve our goals, 

feel happy and improve our quality of life. 

 (A) Stress Management   

 (B) Self-Awareness  

 (C) Self-Growth   

 (D) Self-Motivation  

(v) Which of the following is not an essential quality to become a 

successful entrepreneur ? 

 (A) Confidence    

 (B) Creativity  

 (C) Patience  

 (D) Wealthy    

(vi) In total, how many SDGs were adopted by the United Nations in 

2015 as a universal call to action to end poverty, protect the planet, 

and ensure that by 2030 all people enjoy peace and prosperity ? 

 (A) 13 (B) 11  

 (C) 17  (D) 19  
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2. {XE JE 6 àíZm| _| go {H$Ýht 5 Ho$ CÎma Xr{OE &  51=5 

(i) {ZåZ{b{IV _| go H$m¡Z-gm bjU (ê$n) EH$ g_` _| H$B© \$m°_}Q>m| H$m à`moJ H$aZo 
H$s AZw_{V XoVm h¡ ? 

 (A) {\$b (fill) (B) ñQ>mBëg (styles) 

 (C) q~~  (images) (D) S´>¡J Am¡a S´>m°n (drag and drop) 

(ii) amBQ>a _| ñQ>mBëg Am¡a \$m°_}qQ>J H$m {dH$ën _____________ _oZy Ho$ A§VJ©V 
CnbãY h¡ :  

 (A) BÝgQ© (B) Qy>ëg 

 (C) \$m°_o©Q>  (D) qdS>mo  

(iii) Jm¡ad amBQ>a _| EH$ [anmoQ>© V¡`ma H$a ahm h¡ & O~ ^r dh q~~ (B_oO) H$mo S´>¡J Am¡a 
S´>m°n H$aVm h¡, B_oO CgHo$ XñVmdoµO (S>m°Š ỳ_|Q>) _| Ow‹S> OmVr h¡ Am¡a S>m°Š`y_|Q> H$m 
AmH$ma ~‹T> OmVm h¡ & B_oO Ho$ Ow‹S>Zo Ho$ ~Om` µ\$mBb _| qbH$ H$aZo H$m H$moB© VarH$m 
~VmBE &    

 (A) B_oO H$mo S´>¡J Am¡a S´>m°n H$aZm &  

 (B) S´>¡qJJ H$aVo g_` H§$Q´>mob H$s (Ctrl key) X~mE aIZm & 

 (C) B_oO H$mo S´>¡qJJ H$aVo g_` {eâQ> H$s (Shift key) H$mo X~mE aIZm &   

 (D) B_oO H$s S´>¡qJJ Am¡a S´>m°qnJ Ho$ g_` “H§$Q´>mob” (Ctrl) Am¡a “{eâQ> H$s” 
(Shift key) H$mo X~mE aIZm & 

(iv) _____________ H$s [agmBqµOJ (AmH$ma KQ>mZm-~‹T>mZm) _| B_oO H$m [aµOmoë`yeZ 
~war Vah à^m{dV hmo gH$Vm h¡ &  

 (A) doŠQ>a B_oO (B) amñQ>a B_oO  

 (C) grES>r B_oO  (D) a§JrZ (coloured) B_oO   

 (v) amBQ>a _| _____________ VarHo$/VarH$m| go Amn AnZm Q>oånboQ> ~Zm gH$Vo h¢ &  

 (A) EH$  (B) Xmo   

 (C) VrZ (D) Mma 

(vi) amBQ>a _|_____________ ‘\§$ŠeZ H$s’ H$m à`moJ _ob _O© (mail merge) H$aVo 
g_` S>oQ>m~ogm| H$mo XoIZo Ho$ {bE {H$`m OmVm h¡ &   

 (A) F1  (B) F2 

 (C) F3  (D) F4 
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2. Answer any 5 out of the given 6 questions. 51=5 

(i) Which of the following features allows one to apply a group of 

formats at the same time ? 

 (A) Fill  (B) Styles     

 (C) Images  (D) Drag and Drop     

(ii) In Writer, styles and formatting option is available under _________  

menu.  

 (A) Insert  (B) Tools   

 (C) Format  (D) Window  

(iii) Gaurav is creating a report in Writer. The image gets embedded in 

his document whenever he drags and drops the image and the 

document size increases. Suggest a way to link the image file 

instead of embedding it. 

 (A) Drag and drop the image.   

 (B) Hold down the Ctrl key while dragging.   

 (C) Hold down the Shift key while dragging the image.  

 (D) Hold down the Ctrl and Shift key while dragging and dropping 

the image.  

(iv) Resizing a _________ may badly affect the resolution of an image. 

 (A) Vector image  (B) Raster image  

 (C) CAD image   (D) Coloured image  

(v) In Writer, you can create your own template in _________ way(s).    

 (A) One   (B) Two  

 (C) Three  (D) Four   

(vi) In Writer, _________ function key is used to see the databases while 

implementing mail merge. 

 (A) F1 (B) F2  

 (C) F3  (D) F4  
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3. {XE JE 6 àíZm| _| go {H$Ýht 5 Ho$ CÎma Xr{OE &  51=5  1 

(i) S>oQ>m H$mo g_o{H$V H$aVo g_` _____________ {dH$ën H$m à`moJ H$aVo hþE gob 
aoÝO H$m Zm_ aIm Om gH$Vm h¡ &  

 (A) Zo_ aoÝO$  (B) {S>\$mBZ aoÝO   

 (C) H$Ýgmo{bS>oQ> Zo_  (D) {S>\$mBZ Zo_  

 (ii) S>oQ>m à{dpîQ> Am¡a [aH$m°S>© H$mo AÚVZ (AnS>oQ>) H$aZo Ho$ {bE H$db Am¡a CgHo$ {_Ì 
EH$ ñàoS>erQ> _| H$m_ H$a aho h¢ & dh {H$E JE n[adV©Zm| H$s OmZH$mar aIZm MmhVo 
h¢ & n[adV©Z {H$gZo {H$E Am¡a ñàoS>erQ> _| Š`m n[adV©Z {H$E JE `h OmZZo _| 
{ZåZ{b{IV _| go {H$g {dH$ën go _XX {_b gH$Vr h¡ &   

 (A) ì`y MoÝOoµO (view changes)  

 (B) [aH$m°S>© MoÝOoµO (record changes) 

 (C) ñQ>moa MoÝOoµO (store changes)  

 (D) Q´>¡H$ MoÝOoµO (track changes)  

 (iii) _____________ Jmob grH$ H$m A{YH$ {dñV¥V ê$n h¡ &   

 (A) S>oQ>m~og  (B) hmBnaqbH$    

 (C) [anmoQ>©   (D) gm°ëda  

(iv) _¡H«$mo \§$ŠeÝg H$mo _____________ {bIH$a {Z`{_V H$m`© (regular functions) 
Ho$ ê$n _| {bIm Om gH$Vm h¡ &  

 (A) Void  (B) Return  

 (C) Add-in (D) Dim 

(v) _yb Am¡a g§nm{XV dH©$erQ> H$m à`moJ H$aHo$ dH©$erQ> _| {H$E JE n[adV©Zm| H$mo XoIZo 
Ho$ {bE Calc H$m ____________ {dH$ën (option) _XX H$aVm h¡ &  

 (A) Edit  Revise document   

 (B) Edit  Consolidate  

 (C) Edit  Compare document  

 (D) Edit  Collaborate document  
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3. Answer any 5 out of the given 6 questions. 51=5 

(i) While consolidating data, a cell range can be named using _________ 

option. 

 (A) Name range    (B) Define range   

 (C) Consolidate name   (D) Define name  

(ii) Kawal and his friends are working on a Spreadsheet for entering 

data and updating records. They wish to keep a track of changes. 

Which of the following options will help in knowing who made the 

changes and what changes were done in the spreadsheet ?  

 (A) View changes    

 (B) Record changes  

 (C) Store changes     

 (D) Track changes   

(iii) _________  is a more elaborate form of Goal Seek.  

 (A) Database  (B) Hyperlink  

 (C) Report   (D) Solver  

(iv) Macro functions can be written to behave as regular functions by 

writing a/an _________. 

 (A) Void   (B) Return   

 (C) Add-In   (D) Dim  

(v) _________ option of Calc helps in viewing the changes made to a 

worksheet using original and edited worksheet.  

 (A) Edit  Revise document   

 (B) Edit  Consolidate  

 (C) Edit  Compare document   

 (D) Edit  Collaborate document  
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(vi) Calc _|, eo`S>© dH©$~wŠg (Shared workbooks) _| `h {H$`m Om gH$Vm h¡ :   

 (A) g¡ëg Am_obZ (merging cells)  

 (B) AZwHy${bV \$m°_}qQ>J (conditional formatting) 

 (C) Vñdra/J«m\$ bJmZm (inserting pictures/graphs)  

 (D) nmR²>` gm_J«r Omo‹S>Zm (adding text) 

4. {XE JE 6 àíZm| _| go {H$Ýht 5 Ho$ CÎma Xr{OE &  51=5 

(i) AmonZAm°{\$g ~og _| gma{U`m| (tables) na à`wº$ g§~§Y H$mo ____________ 

{dH$ën H$s ghm`Vm go hQ>m`m Om gH$Vm h¡ & 

 (A) Clear   (B) Remove   

 (C) Drop   (D) Delete  

 (ii) Eg Š`y Eb (SQL) _| [aH$m°S>© H$mo Amamohr H«$_ _| àX{e©V H$aZo dmbm H$sdS>© 
(Keyword) h¡ :  

 (A) Asce    (B) Incr   

 (C) Asc    (D) High 

 (iii) ____________ EH$ Ý`y_o[aH$ S>oQ>m àH$ma h¡ Omo Yes/No Q>mBn d¡ë`yµO H$mo 0 `m 1 

ê$n _| AmonZAm°{\$g ~og Q>o~b _| ñQ>moa H$a gH$Vm h¡ &   

 (A) Boolean     (B) Char    

 (C) Binary     (D) OtherObject  

 (iv) {ZåZ{b{IV _| go H$m¡Z-gm H$WZ (eãX) EH$ `m A{YH$ S>oQ>m~og Q>o~ëg `m S>oQ>m~og 

ì`yµO (views) go eyÝ` (zero) `m A{YH$ n§{º$`m| (rows) H$mo Xþ~mam àmßV H$amVm  

h¡ ?  

 (A) UPDATE      (B) DELETE    

 (C) SELECT  (D) DISPLAY 
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(vi) In Calc, shared workbooks allow :  

 (A) Merging cells    

 (B) Conditional formatting   

 (C) Inserting pictures/graphs  

 (D) Adding text 

 

4. Answer any 5 out of the given 6 questions. 51=5 

(i) In OpenOffice Base, the relationship applied on the tables can be 

removed with the help of _________ option.   

 (A) Clear  (B) Remove  

 (C) Drop   (D) Delete   

(ii) In SQL, the keyword to display records in ascending order is : 

 (A) Asce  (B) Incr 

 (C) Asc   (D) High   

(iii) _________ is a numeric data type which can store Yes/No type values 

in the form of 0 or 1 in OpenOffice Base table.  

 (A) Boolean  (B) Char  

 (C) Binary  (D) OtherObject  

(iv) Which of the following statement retrieves zero or more rows from 

one or more database tables or database views ? 

 (A) UPDATE (B) DELETE 

 (C) SELECT     (D) DISPLAY   
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 (v) amoeZr Zo Eg Š`y Eb (SQL) _o§ H$ñQ>_a Q>o~b V¡`ma H$s h¡ Am¡a dh Cust_photo 
\$sëS>  Ho$ A§VJ©V àË`oH$ Cn^moº$m (customer) H$s \$moQ>moJ«m\$ B_oO ñQ>moa H$aZm 
MmhVr h¡ & EH$ C{MV S>oQ>m Q>mBn H$m ZrMo {XE JE {dH$ënm| _| go gwPmd Xr{OE &    

 (A) B_oO (IMAGE)    

 (B) {nŠMa (PICTURE)    

 (C) bm°ÝJdma~mBZar (LONGVARBINARY)       

 (D) J«m{\$H$ (GRAPHIC)        

(vi) {S>\$m°ëQ> go, AmonZAm°{\$g ~og _| g^r \$sëS> _| ____________ S>oQ>m Q>mBn hmoJm &  

 (A) int (tiny) (B) ~y{b`Z (Boolean) 

 (C) Q>¡ŠñQ> (varchar) (D) Q>¡ŠñQ> (char)  

5. {XE JE 6 àíZm| _| go {H$Ýht 5 Ho$ CÎma Xr{OE &  51=5 

(i) ____________ EH$ n[aMMm© (discussion) àH$ma H$s do~gmBQ> h¡, Omo Am°ZbmBZ 
ì`{º$JV S>m`ar H$s Vah h¡ Am¡a BgH$m à`moJ ì`{º$JV (Personal) do~ noOoµO 
(web pages) V¡`ma H$aZo Ho$ {bE {H$`m OmVm h¡ &   

 (A) WWW      (B) Web    

 (C) ãbm°J (Blog)  (D) M¡Q> (Chat) 

 (ii) ZVmem âbmoa _¡ZoOa Ho$ ê$n _| H$m`© H$aVr h¡ & IVao dmbo ñWmZ H$mo Imbr H$aHo$ 
{H$gr AmnXm `m AmnmVH$mb Ho$ _m_bo _| OrdZ H$s gwajm gw{ZpíMV H$aZo Ho$ {bE 
Cgo {Z`{_V ____________  H$aZo H$m H$m`© {X`m J`m h¡ &  

 (A) gm§ñH¥${VH$ g^m (Cultural assembly)  

 (B) Iwbo H$m`©H«$_ (Open house events) 

 (C) Imbr H$aZo H$m Aä`mg (Evacuation drill)  

 (D) `mÌm Am¡a n`©Q>Z (Trips and excursions) 

(iii) ____________ EH$ gw{dYmOZH$ gmYZ h¡, Omo Eogo bmoJm| H$s ghm`Vm H$aVr h¡ 
{OÝh| H$s~moS>© `m _mCg `m XmoZm| H$m Cn`moJ H$aZo _| H${R>ZmB© hmoVr h¡ & 

 (A) pñQ>H$s H$s $   (B) gr[a`b H$s     

 (C) H§$Q´>mob H$s       (D) Q>m°Jb H$s (Toggle keys)   
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(v) Roshni has created a table Customer in SQL and wants to store 

photograph image of every customer under Cust_photo field. 

Suggest a suitable data type from the options given below.  

 (A) IMAGE  

 (B) PICTURE  

 (C) LONGVARBINARY  

 (D) GRAPHIC 

(vi) By default, all the fields in OpenOffice Base will have _________ 

datatype. 

 (A) int (tiny)      (B) Boolean   

 (C) text (varchar)     (D) text (char)        

5. Answer any 5 out of the given 6 questions. 51=5 

(i) A _________ is a discussion style website similar to an online 

personal diary, used for creating personal web pages.  

 (A) WWW   (B) Web 

 (C) Blog  (D) Chat 

(ii) Natasha works as floor manager. She has been assigned a task for 

conducting regular__________ to ensure safety of life in case of any 

disaster or emergency by evacuating the place of danger.  

 (A) Cultural assembly 

 (B) Open house events  

 (C) Evacuation drill   

 (D) Trips and excursions  

(iii) _________ is an accessibility feature that assists people who have 

difficulty using a keyboard or a mouse (or both).  

 (A) Sticky keys     (B) Serial key 

 (C) Control key   (D) Toggle keys     



  

14-89 14 

(iv) g^r H$åß`yQ>am| Ho$ {bE g_mZ pñW{V dmbo ZoQ>dH©$ ____________ H$ho OmVo h¢ &  

(A) {n`a-Qw>-{n`a Am{H©$Qo>ŠMa (Peer-to-Peer architecture)   

(B) g|Q´>b Am{H©$Q>oŠMa (Central  architecture) 

(C) hmB©am{H©$H$b Am{H©$Q>oŠMa (Hierarchical architecture) 

(D) ŠbmB§Q>-gd©a Am{H©$Q>oŠMa  (Client-server architecture)  

(v) ____________ à¶moº$m Zm‘ (username) Am¡a nmgdS>© O¡go N>moQ>o Am±H$‹S>m| dmbr 
Q>o³ñQ> µ\$mBb| h¢ &   

 (A) Am°naoqQ>J {gñQ>_ (B) E§Q>r-dm`ag 

 (C) Hw$H$sµO  (D) _moS>o_ (Modem)  

(vi) DSL H$m AW© h¡ : 

(A) {S>{OQ>b {gñQ>_ bmBZ (B) S>oQ>m gãgH«$mB~a bmBZ 

(C) {S>{OQ>b gãgH«$mB~a bmBZ (D) S>oQ>m g{d©g bmBZ   

          IÊS> I   
 ({df`naH$ àH$ma Ho$ àíZ)            (26 A§H$) 

amoµOJma H$m¡eb na {XE JE 5 àíZm| _| go {H$Ýht 3 Ho$ CÎma 20 – 30 eãXm| (àË`oH$) _|  
Xr{OE & 32=6 

6. à^mdH$mar g§àofU Ho$ {bE gm§ñH¥${VH$ {d{^ÝZVmE± {H$g àH$ma EH$ ì`dYmZ hmo gH$Vr h¢ ?  

7. CÚ{_Vm Ho$ ~mao _| {H$Ýht Xmo µJbV YmaUmAm| H$mo ñnîQ> H$s{OE &  

8. OrdZ _| gµ\$b hmoZo Ho$ {bE g_` à~§YZ H$m¡eb Ho$ _hÎd na g§{jßV MMm© H$s{OE &  

9. h_ A{YH$Va ñn¡_ _oëg (Spam mails) Ho$ ~mao _| gwZVo h¢ & `o AZMmho g§Xoe (Spam 

mails) Š`m h¢, ñnîQ> H$s{OE Am¡a ~VmBE {H$ Eogo g§Xoem| (mails) Ho$ gmW Š`m H$aZm 

Mm{hE &  

10. gm\$ Am¡a dhZr` (affordable) D$Om© àmßV H$aZo Ho$ {H$Ýht Xmo VarH$m| H$m CëboI H$s{OE &  
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(iv) Network in which all computers have equal status is called 

_________ .  

 (A) Peer-to-Peer architecture  

 (B) Central architecture  

 (C) Hierarchical architecture 

 (D) Client-server architecture  

(v) _________ are text files with small pieces of data – like a username 

and password. 

 (A) Operating System   (B) Antivirus   

 (C) Cookies (D) Modem  

(vi) DSL stands for _________ . 

  (A) Digital System Line  (B) Data Subscriber Line  

 (C) Digital Subscriber Line  (D) Data Service Line  

Section B 

                                           (Subjective Type Questions)                         (26 Marks)  

Answer any 3 out of the given 5 questions on Employability Skills in 20 – 30 

words each.     32=6 

6. How can cultural differences be a barrier to effective communication ?  

7. Explain any two misconceptions about entrepreneurship.  

8. Briefly discuss the significance of time management skills in order to 

succeed in life.  

9. Very often we hear about spam mails. Explain what are spam mails, and 

what should be done with such mails.  

10. Mention any two ways to get clean and affordable energy.  
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{XE JE 6 àíZm| _| go {H$Ýht 4 Ho$ CÎma  20 – 30 eãXm| (àË`oH$) _| Xr{OE & 42=8 

11. amBQ>a _| S´>mB§J Am°ãOoŠQ>g H$mo J«wn H$aZo Ho$ _w»` MaUm| H$mo {b{IE &  

12. ñàoS>erQ> _| S>oQ>m g_oH$Z (consolidate) H$m Š`m CÔoí` h¡ ? g§jon _| ~VmBE &  

13. LAN Am¡a WAN _| A§Va ~VmBE &  

14. Xÿgar erQ>m| _| S>oQ>m àofU H$aZo Ho$ {bE gob ao\$a|g Ho$ Xmo ^mJ Š`m h¢ ? CXmhaU Ho$ gmW 

ñnîQ> H$s{OE &  

15. S>oQ>m~og _| gma{U`m| (tables) Ho$ ~rM g§~§Y V¡`ma H$aZo Ho$ {H$Ýht Xmo bm^m| H$mo ~VmBE & 

16. {H$gr g§JR>Z Ûmam AnZmE OmZo dmbo {H$Ýht Xmo àmW{_H$ A{½Z gwajm {Z`_m| H$m CëboI 

H$s{OE &   

{XE JE 5 àíZm| _| go {H$Ýht 3 Ho$ CÎma  50 – 80 eãXm| (àË`oH$) _| Xr{OE & 34=12 

17. dS>© àmogoqgJ gm°âQ>do`a _| _ob _O© (mail merge) H$aZo H$s Š`m AdYmaUm h¡ ? {dñV¥V 

ê$n go ~VmBE & _ob _O© Ho$ à`moJ Ho$ {H$Ýht Xmo bm^m| H$mo ^r ~VmBE &  

18. hmBnaqbH$ Ho$ Mma àH$mam| H$mo ñnîQ> H$s{OE {OZH$m à`moJ ñàoS>erQ²>g _| {H$`m Om gH$Vm  

h¡ &  

19. B§Q>aZoQ> H$s gwajm AmO H$s g~go ~‹S>r qMVm H$m {df` h¡ & H${R>Z nmgdS>© H$m à`moJ B§Q>aZoQ> 

H$s gwajm Ho$ A{VH«$_U Ho$ IVao H$mo H$_ H$a gH$Vm h¡ &  

 {h_m§er Zo A^r-A^r B§Q>aZoQ> AmYm[aV AnZm nhbm EH$mC§Q> ~Zm`m h¡ & H${R>Z nmgdS>© 

V¡`ma H$aZo Ho$ {bE {H$Ýht Mma gm_mÝ` {Xem-{ZX}em| H$mo ~VmVo hþE CgH$s _XX H$s{OE & 

20. AmonZAm°{\$g ~og Ho$ g§X^© _| {ZåZ{b{IV H$s AdYmaUm Am¡a _hÎd H$mo ñnîQ> H$s{OE :  
(a) \$m°åg©   
(b) [anmoQ²>©g 



  

14-89 17 P.T.O. 

Answer any 4 out of the given 6 questions in 20 – 30 words each.  42=8 

11. Write the main steps to group drawing objects in Writer.  

12. What is the purpose of consolidating data in spreadsheets ? Discuss 

briefly. 

13. Differentiate between LAN and WAN.  

14. What are the two parts of a cell reference while referencing data on other 

sheets ? Explain with an example. 

15. Give any two benefits of creating relationships between tables in a 

database.  

16. Mention any two basic fire safety rules to be followed in any organization. 

Answer any 3 out of the given 5 questions in 50 – 80 words each.  34=12 

17. What is the concept of mail merge in word processing software ? Discuss in 

detail. Also give any two major benefits of using mail merge.  

18. Explain four types of hyperlinks that can be applied in spreadsheets.  

19. Internet security is of prime concern nowadays. Using strong passwords 

can lower the risk of security breach on the Internet. 

 Himanshi has just created her first Internet based account. Help her by 

giving any four general guidelines for managing strong passwords. 

20. In context of OpenOffice Base, explain the concept and significance of the 

following :   

(a) Forms    

(b) Reports   
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21. Q>o~b àmoS>ŠQ> na {dMma H$s{OE Am¡a {ZåZ{b{IV Ho$ {bE (SQL) ŠdoarµO {b{IE : 

Q>o~b : àmoS>ŠQ> 

nrAmBS>r àmoS>ŠQ>Zm_ _yë` _mÌm  loUr 

P01 ~moS>©  10000 2 Am°{\$g 

P02 AmBbmBZa  700 50 _oH$An 

P04 n|{gb 5 500 ñHy$b 

P05 b¢n> 250 10 Kaoby 

P08 ~oS>erQ> 450 45 Kaoby 

P09 b¡nQ>m°n 75000 15 Am°{\$g 

(a) CZ g^r CËnmXm| (àmoS>ŠQ²>g) Ho$ Zm_ {XImZm {OZH$s loUr ‘‘Kaoby’’ h¡ &  

(b) CZ CËnmXm| Ho$ àmoS>ŠQ>Zm_ Am¡a _yë` {XImZm {OZH$s _mÌm 50 go H$_ h¡ &  

(c) b¡nQ>m°n H$m _yë` Am¡a _mÌm (g§»`m) {XImZm & 

(d) CZ CËnmXm| H$m àmoS>ŠQ>Zm_ Am¡a _mÌm {XImZm {OZH$m _yë` 5000 go A{YH$ h¡ &  

ÑpîQ>~m{YV narjm{W©`m| Ho$ {bE :>  

S>oQ>m~og à~§YZ àUmbr Ho$ g§X^© _| {ZåZ{b{IV na EH$ g§{jßV {Q>ßnUr {b{IE :  
(i) S>oQ>m~og 

(ii) Q>o~b 

(iii) µ\$sëS> 
(iv) H$ånmo{OQ> àmB_ar H$s  
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21. Consider the table Product and write SQL queries for the following :  

                                   Table : Product 

PID PNAME PRICE QUANTITY CATEGORY 

P01 BOARD 10000 2 OFFICE 

P02 EYELINER 700 50 MAKEUP 

P04 PENCIL 5 500 SCHOOL 

P05 LAMP 250 10 DOMESTIC 

P08 BEDSHEET 450 45 DOMESTIC 

P09 LAPTOP 75000 15 OFFICE 

 

(a) To display names of all products whose category is ‘‘domestic’’.   

(b) To display product name and price whose quantity is less than 50. 

(c) To display price and quantity of Laptop. 

(d) To display name and quantity of those products whose price is above 

5000.  

For Visually Impaired Candidates : 

In the context of Database Management System, write a short note on the 

following : 

 (i) Database   

(ii) Table  

(iii) Field  

(iv) Composite Primary Key  

 


